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accompanying compact disk, in whole or in part, without the written consent of Horticopia, Inc., except in the
normal use of the installation and backup of the software. The software may be used only on one computer at a
time. Use on a network for access by multiple users requires licensing from Horticopia, Inc. The copyright
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warranties of merchantability or fitness for a particular purpose with respect to the software and the accompanying
materials, if any. This limited warranty gives you specific legal rights. You may have others which vary from
jurisdiction to jurisdiction. The warranty set forth above is in lieu of all other expressed warranties whether oral
or written. Agents, employees, distributors, and dealers of Horticopia, Inc. are not authorized to make modifications
to this warranty, or additional warranties on behalf of Horticopia, Inc.
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HORTICOPIA
Dear HORTICOPIA Customer,
We wish to thank you for purchasing HORTICOPIA A to Z. Whether you are new to HORTICOPIA, or adding to
your HORTICOPIA library, we’re confident that this latest product will meet and exceed your needs and expectations.
The first edition of HORTICOPIA Perennials and Annuals set the standard in CD-ROM based horticultural reference.
Subsequent releases added quite a few ease of use features to support the larger number of pictures and plants.
With A to Z, HORTICOPIA raises the standard again. Our unique Garden Workbench® with its intuitive and
powerful searching and retrieval capabilities has been fine-tuned with more “expert knowledge” built in and a host
of added features to make it even easier to use.
We appreciate the suggestions and comments from our many users that we’ve received with our previous HORTICOPIA releases. The changes we’ve incorporated reflect, in part, those many user inputs. Foremost among the
new features are:
·

Garden Workbench Now reorganized to allow the selection and integration of both woody and herbaceous
plants. A new preview window allows you to instantly see the preferred picture of the plant you have highlighted in the list.

·

Botanical Names As always, we’ve updated our botanical names and kept the old ones in parentheses so you
can find plants that way too. The names now reflect the nomenclature found in the New Royal Horticultural Society
Dictionary of Gardening. If this source did not list a plant, we then deferred to Hortus Third. In those cases where
neither source had a reference, we relied on the expertise of our horticultural advisers from academia.

·

Print Layout This very popular feature has been expanded by letting you add your own text directly onto the
print page. The information copied to the print page from HORTICOPIA can now be edited as well.

·

List Editor The popular lists menu has been expanded to include the lists of various special interest groups.
The new list editor allows you to select which lists you want to see and even create your own lists to be
included unders the lists menu.

·

Plant and Picture Collection With over 9500 pictures representing in excess of 4000 plants, you’ll find our
collection to be the most comprehensive available. For the first time we have integrated both woody and
herbaceous plants on one CD.

Along with the entire HORTICOPIA Development team, I hope you enjoy using this product as much as we
enjoyed creating it for you.

September 1999

Letter

Anne Muecke,
Editor and Publisher
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Introducing
HORTICOPIA A to Z
This chapter provides you with information on system requirements, installation or removal of HORTICOPIA A to
Z. You will also learn how to run the program and where to get additional help with A to Z.

Welcome to HORTICOPIA
A to Z is the most comprehensive on-line multimedia reference available for horticultural information. The
collection of pictures, ease of access and rich features found in A to Z will make HORTICOPIA your standard in
CD-ROM horticultural reference.
If you are familiar with other Windows 95 applications, then learning to use A to Z effectively will be very
straightforward. A to Z uses common Windows conventions including menus, lists, and multiple windows. A to Z
is a full-featured program that provides in-depth coverage and flexibility. Please spend a few minutes familiarizing
yourself with its basic operations and you’ll be on your way to getting the most out of A to Z.

Installation
A to Z is installed on your computer with the Setup program. The A to Z program itself, help files, supporting data
files, and library files are copied to your hard disk during setup. On many Windows 95 and NT systems, simply
inserting the CD will start the Setup program.
You must run the Setup before you can use A to Z.

Before You Run Setup
Your system must meet the minimum requirements before you install and run A to Z. The accompanying table
summarizes these system requirements. However, successful installationdoes not guarantee that your system
meets the requirements necessary for running A to Z.

Requirements

Minimum

Recommended

Processor

Pentium or equivalent
Windows 95 -- 16
megabytes
Windows NT -- 24
megabytes

Faster is better

Main memory (RAM)

Hard disk space

3 megabytes available

CD-ROM drive

2 speed

Mouse or other
pointing device

required

Video adapter

Monitor
Windows compatible
sound
Printer
Operating System
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32 megabytes or more
12 megabytes or more
available; if running with
one CD-ROM drive, 650
megabytes available
At least two CD-ROM
drives, 4 speed or faster
required

High color (thousands of
colors, 16 bit color, or
Display of 256 colors, but
65536 colors) or better
it will run slowly and
(true color, 24 or 32 bit
colors will not be optimum
color, millions of colors, 16
million colors)
640 by 480 screen
800 by 600 or higher screen
resolution
resolution
Required to hear botanical
Optional
names and background
music
Windows compatible color
Optional
printer
Windows 95, Windows NT
Version 4, or later
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Setting Up A to Z
Many Windows 95 and Windows NT CD-ROM drives support Autoplay. Simply insert the A to Z CD set in your
CD-ROM drive. In a few seconds, the A to Z setup program should start.
If the automatic start-up of Setup does not work on your configuration or causes a problem, you may install A to
Z as follows:
1. From your taskbar’s Start button, select Run…
2. Enter d:\setup32\setup
If your CD-ROM drive is not on drive D, substitute the appropriate drive
letter.
3. Click on OK
Once setup starts, you will be asked to supply certain optional information. Follow the setup instructions carefully.
If you get any error messages when trying to start Setup, be sure that your Windows system recognizes the CD.
Open My Computer and make sure you see the A to Z CD icon and the A-Z volume name. Note the drive letter
next to the icon.
Alternately, you can locate the A to Z CD in My Computer or with your Windows Explorer. Click on the A to Z icon
with the right mouse button and then select Install A to Z
During the setup process, you have the option of choosing Typical, Compact or Custom installations. Unless you have
compelling reasons to do otherwise, we strongly recommend that you use the Typical installation option. A toZ
occupies minimal disk space, since all the photographs and sound remain on the CD.
If you are very short on disk space, you may choose the Compact installation option. This saves about 3.5
megabytes of disk space, but there will be a performance penalty during execution.
Some users desire a portable A toZ system where it can be run on a variety of computers with minimal installation.
This feature may be attractive to students who run the software in computer labs. To use this mode, you must still
install the runtime libraries used by A to Z . Choose the Custom setup option and select only System Files.
You can then run A to Z directly from the CD as follows:
1. From your taskbar’s Start button, select Run…
2. Enter d:\run_cd\a-z If your CD-ROM drive is not on drive D, substitute the appropriate drive letter.
3. Click on OK.
If you have personal notes that you wish to create and use during CD run sessions, enter /MEMO=[full path and
name of user notes file] after the run command. Examples:
d:\run_cd\a-z /memo=c:\docs\horticopia notes.not
e:\run_cd\a-z /MEMO=d:\docs\hortnote.xxx

Starting A to Z
The CD MUST be in a CD-ROM drive to run A to Z
If you chose the default installation group, select A to Z from your Start menu’s Programs. Otherwise, start A to Z
from the program group you chose at installation time.
Do not remove the CD while A to Z is running. You may experience errors if you do so.

Getting Assistance While You Work
A to Z provides you with additional information while you are running the program. The on-line help is always
available by pressing the F1 key.

Smart Cards
When you first start A to Z , Smart Cards will appear to guide you through the most commonly used features of
A to Z . If you wish to recall Smart Cards that you have closed out, you may do so with the appropriate Help menu
selections.
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2

On-line help
The A toZ on-line help follows standard Windows conventions. The help can be started from the Help menu or
by pressing the F1 key. The entire on-line help document may also be printed by following the instructions found
in the chapter titled Additional A toZ Information.
You can print individual help topics with the help system’s Print Topic.

Context sensitive help
When you press the F1 key, A toZ will present the help section relevant to the area you are currently working in.
For example, if you are working with a Print Layout, pressing F1 will display the help related to the Print Layout.

Tool Tips Help
The Garden Workbench® graphics, buttons and list icons have specific information that may be viewed by placing
the mouse cursor over the graphic or button and then not moving the mouse for a couple of seconds. This feature
is also available with the navigation buttons displayed with the plant information window and with the slide show
tool bar buttons.

Link to Technical Support Web Page
Within the on-line help, we have provided links to our technical support web pages. If you have an Internet
connection, you may use these links to access the HORTICOPIA website. Here you may find additional information
concerning questions you have about A toZ. We will post technical bulletins as well as any software revisions.

Removing A to Z
During the setup process, A to Z creates the procedures necessary for removing the software.
From your Control Panels, open Add/Remove Programs. Find HORTICOPIA A to Z in the list and remove it. If,
for some reason, you wish to reinstall A to Z, you should always remove it first.

In Case of Problems
During program setup, you may get a message asking you to quit other running applications. Typically, applications
tup folder. You may temporarily copy the entries
on a system that has just been started will be found in the S t ar
artup
tup folder to another folder or group and restart your system. After installation is complete, the
in the S t ar
artup
tup folder may be restored.
contents of the S t ar
artup
You can also attempt to resolve the conflict by terminating other running applications. First, you should step
through all active applications and terminate each one. You can cycle through the active applications by holding
down the Alt key and then pressing the Tab key.
If you still have problems, you can view the current task list as follows:
1. Hold down the Ctrl and Alt keys and press on the Del key (Windows 95) or, for Windows NT, click on the
task bar with the right mouse button and select Task Manager...
2. Explorer and Systray should always be in the task list. Other items may be the cause of installation conflicts.
If you’re not running on a network, then try terminating the additional tasks listed and try reinstalling. If
you’re on a network, you should contact your Network Administrator.
A to Z is a graphics intensive application. It works correctly with all systems configured with Windows standards
compliant components. You may experience program crashes if your system uses drivers that are not Microsoft
certified. Be sure to read the README.TXT file on the CD if you experience such problems.
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Getting Started with A to Z
In this chapter, you will learn how to perform some of the common tasks in HORTICOPIA. Spending a few
minutes reading this chapter will put you on the fast track to being a proficient HORTICOPIA user. If you are
already familiar with previous HORTICOPIA products, you may wish to get started with the software right away
and consult the on-line topic Quick Start for A to Z Users.

HORTICOPIA Concepts
HORTICOPIA A to Z is a “standard” Windows software application. If you’ve worked with other Windows programs
such as word processors, spreadsheets, graphics design packages or database systems, then you will already be
comfortable with many of the aspects of A to Z.

Nomenclature
The on-line help contains an extensive glossary of terms used in A to Z. There are a few unique terms and usages
within the software that will help in understanding the remainder of this chapter.
Alias an additional common name for the same plant
Garden Workbench the main HORTICOPIA window from which most tasks are accomplished
Layout (Print Layout) the composition of pictures, data and text created by the user with the intent of
printing
MyList plant names that have been designated by the HORTICOPIA user as being special; MyList plants
appear in green lettering
Preferred Picture the picture designated as representative of the plant whenever several pictures are present;
it appears first among the plant’s preview pictures
Screening the process of displaying only some of the available plants in the list; screening may be by MyList,
hardiness zone, or other factors
Thumbnails a set of small pictures showing the preferred picture for a group of plants

The Garden Workbench®
The heart of HORTICOPIA is the Garden Workbench. From here, you’re just a couple of clicks away from
getting the information you need for any of the plants in A to Z. You can search for plants, select plants of interest
to you, create lists, compare pictures from different plants, hear the botanical names pronounced, switch between
common or botanical names, and much more.
The accompanying illustration shows the A to Z Garden Workbench annotated with circled key numbers. These
keys identify the most important areas:
1.

Workbench Preview - When HORTICOPIA A to Z starts, this area contains an A to Z introductory graphic.
After clicking on a plant name, the first of the preview pictures is displayed in this area. A large screen view
of the picture is retrieved by clicking on this image. When a plant category is selected, this image is replaced
by the selection tabs for that plant category.

2.

Main plant selection - comprises the primary selection criteria for the plant. These include hardiness, soil
type, category, moisture, and exposure. Select any combination of environmental attributes and the hardiness
zone. The hardiness you select is used for all future selections. You must change or reset the hardiness if you
want a different setting. Hold the mouse steady over any of the graphics to get a brief explanation.

3.

Action Button -- displays the information window for the plant whose name is highlighted in the plant list

4.

Sound Button -- provides audio of the botanical name for the name of the plant highlighted in the plant list

5.

Attribute Button -- outlines the graphics in the main plant selection area as well as in the tab areas with a
green border to reflect the characteristics of the plant highlighted in the plant list. This provides a graphic
view of the plant’s characteristics and lets you quickly find similar or compatible plants.
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6.

Thumbnails Button -- displays thumbnail views of the plants highlighted in the plant list. If no plants are
highlighted, all plants in the list will appear in the thumbnails view.

7.

MyList Button -- alternately shows only the plants you have placed on MyList or displays all the plants.

8.

Switch Names Button -- changes the list between botanical and common names.

9.

Clear Button -- resets the plant list. Any screening in effect remains and will affect the contents of the list.

10. List Counter displays the number of plants currently displayed in the list. The counter is updated as you perform
plant selections.
11. High level list folder -- clicking on this icon alternately expands and collapses the plant list.
12. Selected plant name -- the currently selected plant name appears as highlighted.
13. Continuation --- for plant names too long to fit on one line, clicking on the continuation button will display
the full name.
14. Genus species list folder -- for plants that have several cultivars, a grouping of the cultivars is expanded or
hidden by clicking on this icon.

11
1
13
3
4

12

5
6
7
8
9
10
2
14

15
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15. Herbaceous Basics tab appears when the Herbaceous plant category is selected and allows you to select
desired bloom colors, bloom time, summer leaf colors, plant type, and plant height.
16. Herbaceous Features/Form tab is used to specify growth rate, plant form, and various features relevant to
herbaceous plants.
17. Woodies Basics tab appears when the Woodies plant category is selected and allows you to select desired
bloom colors, bloom times, summer and fall leaf colors, plant types, and the height or spread.
18. Woodies Features tab is used to specify persistence, flammability and other plant characteristics, as well as,
growth rate.
19. Woodies Canopy tab allows the user to select a form or shape. Again, hold the mouse steady over any of the
graphics to get a brief explanation.
20. Woodies ID Details tab opens up five additional tabs that let you specify various leaf characteristics such as
margins, shape, venations, arrangement, and type as well as fruit and bark characteristics.

The ABCs to Plant Information
·

If you want botanical names, click on (8) , the Switch Names Button

·

Using the high level list folder (11), locate the name of the plant you want information about; use (14) if there are several
cultivars available; use (13) to reveal a name that is too long to fit in the list window.

·

Click once on the name of the plant you’re interested in so it’s highlighted

·

Click on (3), the action button, or double click on the plant name

·

Double-click on a preview picture or on one of the other tabs

Understanding Plant Lists
The plant list on the Garden Workbench lets you find plants, create your own lists, refine plant searches, and see
plant names in different arrangements or naming conventions. Using the plant list effectively will reward you with
saved time and the ability to fully exploit the capabilities of A toZ.
You should use the Customize options (press F11) to adjust the list’s appearance to your preferences. You can set
the font type and size to get the best combination of readability and number of plants displayed together. Be sure
to set the default expansion level to genus and species or to cultivars if you don’t want the list to always start out
with only the letters of the alphabet. You can also change the expansion level from the Workbench menu, but this
does not change the default expansion level. You may also group the plant list by families instead of alphabetically.
You can switch the sort order of the plant list between botanical names and common names at any time by clicking
on the Switch Names Button (8). The Workbench menu lets you expand or collapse the entire list.
You’ve probably already discovered that you can highlight a plant name by clicking on it once. You can also highlight
several plant names by holding down the Ctrl key while selecting them. Holding down the Shift key highlights all the
plants from the previously highlighted one through the one you’re currently pointing to. Multiple plant selection is
useful in printing plant lists, creating slide shows, viewing only selected plants and in working with your own plant
lists.
You can designate plants to be on your own special list. In HORTICOPIA, this list is called MyList. You can click
on a plant name with the right mouse button to add or remove it from MyList. When a plant is on MyList, its text
appears in green. You can add several highlighted plants to MyList pressing the + key. The entire list (usually after
a search) can be added by selecting Add All to MyList from the Workbench menu. You can create several different
MyLists. You save each MyList with the File menu Save As... selection. The Open menu lets you load previously
saved lists. The most recently saved MyList files appear at the bottom of the File menu.
When working with common names, you may notice that when you highlight a plant name, other names appear as
grayed text. These are additional common names, or aliases, of the common name you highlighted. Once you add a
common name to MyList, the name you chose becomes the preferred common name. When you look at only plant
names belonging to MyList, then you will see only the preferred names you have selected. Clicking on the MyList
button (7), alternately shows only the plants on MyList or all the plants currently on the list.
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When you are viewing only the MyList plants, you can rearrange the order of the plant names by first selecting a
name or names by clicking on them.; then again clicking and holding the mouse down over the selected names
until a double-headed red arrow appears, and then dragging them to elsewhere in the list. The names appearing
on the list are also screened by any hardiness zones you have selected. You may also screen by personal notes by
selecting Personal Notes Screening from the Workbench menu.
Other plant list tools you’ll want to become familiar with include the Find (see the Workbench menu) which lets
you search the list for specific words or even portions of words. You can also type in the first few letters of a plant
name, and the plant list will jump to the first entry beginning with those letters. There are also several shortcut
keys you can use with the plant list. Press F1 while you’re on the Workbench and look for “Keyboard Shortcuts.”

Quick Tour 1 — Printing Pictures
You should start A to Z on your computer when taking this tour. You will learn how to print pictures and
information from A to Z. Be sure your printer is set to portrait orientation with letter size paper.
1. To start this tour, your plant list should be in common name order and collapsed, with only the letters A-Z visible
and neither Woodies nor Herbaceous selected. Click on

, the Switch Names Button, and on the Workbench

menu, Collapse List, if needed. Make sure no hardiness zones are selected on the Main area of the Garden
Workbench. You can make sure there are no MyList items by selecting Remove all from MyList on the Workbench
menu.
2. Click once on the tan folder icon next to the letter D.
3. Click once on the name Daffodil (sp). Your plant list should now look similar to the following graphic with
the plant name highlighted:
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4. Click on

, the action button, or double click on the plant name.

5. Now, click once on the second preview picture and the fourth preview picture. A green rectangle will appear
around each of these pictures. The plant information window should look like:

6. Click on the Print
7.

button in the plant information window.

You will now see the Layout window with the two pictures you’ve selected. You can move the pictures around
with the mouse and resize them by dragging the green corners in a diagonal direction. Arrange the pictures so
your window looks like:

8. Press the F7 key to bring the information window to the front.
9. Click on the Information tab
10. Now, click on the Print

button as before (see Step 6)

11. Move the information text box towards the bottom of the layout page.
12. From the Layout menu, select Insert Text...
12. In the text box that appears, type “Working with the HORTICOPIA Layout”

Getting Started with A to Z

8

13. Click on Font... and make the font bold and select a size of about 18 points. Click on OK, and your text box
will appear in the Layout.
14. You can move and resize the text box just like pictures. Arrange your layout so it looks somewhat like:

You can insert returns in your text to control its position vertically inside the text box.

15. You’re now ready to print. From the Layout menu, select Print...
16. Make any adjustments required by your printer and click on OK.
17. Printing may take a while, depending on your system and printer. Be patient, in a few minutes you should
have a printout.
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Quick Tour 2 — Searching for a Plant
1. To start this tour, your plant list should be in common name order and collapsed, with only the letters A-Z
visible. Use the Workbench menu Collapse List selection, if needed. Make sure no hardiness zones are
selected on the Main area of the Garden Workbench. You can make sure there are no MyList items by
selecting Remove all from MyList on the Workbench menu.
2. Click on

, the Switch Names Button, so that your list is in botanical name order. You can peek at the

list by expanding one of the folders next to a letter and making sure the list is in the right order. Click on
again if it is not.
3. Select the Woodies plant category from the Main area of the Garden Workbench.
4. Again on the Main area of the Garden Workbench, select hardiness zone 8b by clicking on the rightmost
rectangle next to the number 8.
5. Find the Basics tab which appeared when the Woodies plant category was selected.
6. Click on the yellow bloom petal. As you click on these plant characteristics, note the plant counter just below
the workbench buttons. It shows the number of plants that match your current search specifications. The
plant list also updates automatically each time you make a plant characteristic selection.
7.

Click on the 4’ to 6’ and the 6’ to 10’ height zones. This means you want to select plants in the range of 4’ to
10’ high.

8. Your Workbench should now look something like the following illustration with approximately 64 plants
displayed.

9. Click on the Canopy tab on the Garden Workbench and select the rounded form graphic -- this represents a
round tree form.
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10

10. Click on

, the Thumbnails button. You should get a thumbnail window that shows the first picture of

each plant in the list:

11. Enlarge the thumbnails view by clicking on the

maximize button at the upper right corner of the

thumbnails window.
12. Double-click on a picture in the thumbnails view and you’ll get a full-sized view of that picture.
13. Now, close the full sized picture.
14. Double-click on one of the names below a thumbnail picture. You’ll get the information window for this
plant.
15. You can now explore other plants with the thumbnails.
16. When you’re done, close the information window and the thumbnail window.

Quick Tour 3 — Working with the Plant List
In this tour, you will learn more about how to use the plant list effectively.
1. To start this tour, your plant list should be in botancial name order and collapsed, with only the letters A-Z
visible. Click on

, the Switch Names Button, and, on the Workbench menu, select Collapse List, if

needed. Make sure hardiness zones are not selected on the Main area of the Garden Workbench by clicking
on

, the Clear button, with the Ctrl key held down. You can make sure there are no MyList items by

selecting Remove all from MyList on the Workbench menu.
2. From the Workbench menu, select Find... or press F3
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11

3. Type in the word “virginia” as shown. All Find operations are case insensitive, so you can enter “Virginia”
instead.

4. Click on the Find button. Your plant list will now show all of the plant names that contain the letters
“Virginia.”

5. You can include more than the plant list in your searches. Click the

Clear button. Try the Find again and

this time check the Culture notes box and click on the Find button again. This may take 12-15 seconds
depending on the speed of your computer. The plant list now includes the previous names plus all those with
the letters “Virginia” in the culture notes.
6. Select (highlight) one of the plant names without the letters “Virginia” and then click on

, the Action

button. Now, click on the Notes tab and see that the Culture notes contain the letters “Virginia.”.
7.

Click on the information window’s workbench button

to close the window and return you to the

Workbench.
8. From the Workbench menu, select Collapse List
9. Quickly type the letters “po”
“po”. The plant list should jump to Polygonum virginianum. If you didn’t get to this entry,
scroll the list to the top and try again. You have about a second between entering letters before the next letter
is interpreted as a starting character.
10. Experiment with typing in other letters. Type “am” and you should jump backwards towards the Amelanchier
arborea entry.
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11. From the Workbench menu, select Show all Plants to create a “working” plant list that will be used for the
remainder of this tour.
12. Now click on

, the Switch Names Button. Your list should show common names and contain

approximately 62 plant name entries. It will look similar to:

13. From the Workbench menu, select Add All to MyList.
14. Note the alias names that appear in grey letters. Now, click on

, the MyList button. You now have added

the current plants to the My List and have clicked the My list on. To click it off you simply click on the My
List button again. At this point, you can now click on

, the Clear button, and you’ll always get back to

the MyList since that’s what you’re currently working with.
15. The alias names will disappear and you will get a green counter (10) below the Workbench buttons showing
you the the number of plants in the list. This counter should now read 62.
16. Select the Woodies plant category from the Main area of the Garden Workbench. Click on the Features tab
that appears. Now, under the Tolerates section, click on the drought feature.
17. You should now see the names of the plants found to be drought tolerant among the MyList plants in your list.
18. Click on

, the Switch Names Button, and your list is instantly changed to the botanical names representation

of your plants.
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19. Click on , the MyList button and, from the Workbench menu, select Remove All from MyList. Your list should
now be back to its original state.

Quick Tour 4 — Using the Edit Lists Menu

The Lists menu has several preset lists that are easily retrieved by clicking on the menu item and selecting the
list needed. It is then automatically displayed. You can choose Edit Lists to determine which of these lists are
displayed and which are suppressed and not visible. This tour walks you through the creation of your own
custom list to be displayed under this menu.
1. To start this tour, your plant list should be in common name order and collapsed, with only the letters A-Z
visible. Use the Workbench menu Collapse List selection, if needed. Make sure no hardiness zones are
selected on the Main (2) area of the Garden Workbench. You can make sure there are no MyList items by
selecting Remove all from MyList on the Workbench menu.
2. Click on

, the Switch Names Button, so that your list is in botanical name order. You can peek at the

list by expanding one of the folders next to a letter and making sure the list is in the right order. Click on
again if it is not.
3. Scroll through the list, open folders by clicking on them to reveal the plant names, and select your 10 favorite
plants in the list by clicking on them with the right mouse button. The color of the name displayed should
change from blue to green.
4. Once you select your 10 favorite plants, click on

, the My List button. The list should now show only the

the 10 plants you selected. (to return to the main list for additional selections click on the

, My list

button again, make selections then return to My List which displays only your selections)
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5. At this point, click on the Lists menu and select Edit Lists. Then the following window should appear.

6. Click on the Add new list button. The name “New Plant List” will appear in the list and in the window above
the list. Click in the top window and type “My Favorite Plants” as the name for your new list. It will
automatically change to the new name in the list.

7.

Click the OK button. Your list is saved and appears under the Lists menu for instant retrieval. You can
create multiple custom lists. These lists can be deleted at any time by recalling the Edit Lists menu,
highlighting the name in the list and clicking on the Delete button on screen.

8. Click on

, the MyList button and, from the Workbench menu, select Remove All from MyList. Your list

should now be back to its original state.

Getting Started with A to Z
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Additional Information
In addition to this User Guide, HORTICOPIA A to Z (Abelia to Zygopetalum) provides extensive on-line information on
using the product effectively and on solving potential problems.

On-line Help
The on-line help is accessed within HORTICOPIA by pressing function key F1 or by selecting the appropriate item
from the Help menu. The on-line help may also be viewed without starting A to Z by opening or double-clicking on
the help file.
The on-line help is normally installed in the HORTDATA folder (directory) that is found in the installation
folder. The default installation location is Program Files\HORTICOPIA\A-Z. The help file is also on the CD in
Run_CD\Hortdata\ A-Z.hlp.

Printing the Help Guide
A copy of the on-line help system has been stored in Microsoft Word format on the CD. It is in the Extras folder
and is named Guide.doc. If you wish to refer to the help information as a printed document, you can print this
document for future reference.
If you do not have a compatible version of Microsoft Word installed on your system, you can install Microsoft’s
Wordview software which lets you view and print Word documents, but does not permit editing. Follow the
installation instructions by reading the INSTALL.TXT file located in the Wordvu folder contained in the Extras
folder.

HORTICOPIA Web Site
HORTICOPIA’s web site is at http://www.horticopia.com
We have a section devoted to technical support. You can access this section directly at http://www.horticopia.com/
techsupp. If you have any questions that aren’t answered by this User Guide or the on-line help, take a look at our web
site for up-to-the-minute information. You can also e-mail our technical support staff from the web page.

Contacting HORTICOPIA
Horticopia, Inc. provides HORTICOPIA specific technical support to registered users. Please be sure to read the
User Guide and on-line help information before contacting technical support. If you have problems with Windows,
your computer system, or other software, please contact the vendors of those products.
Our technical support staff will be happy to assist you with any problems you experience installing or running
HORTICOPIA. Please read this User Guide or use the on-line help before contacting Technical Support.
When contacting us for technical support, be sure to include the following information:
1. Name and telephone number, along with hours at which you may be reached
2. Type of system you are running (Windows 95, 98, 2000, or Windows NT)
3. Version of the HORTICOPIA software you are using (under the HORTICOPIA Help menu, select System
Parameters to get the version number)
4. Description of the problem, including what actions you took to cause the problem to occur.
Send e-mail to support@horticopia.com. We will usually get back to you the same day. Alternately, you may fax
this information to (540) 338-4580
To contact us by telephone, call (540) 338-9147 between 9:00 AM and 6:00 PM Eastern time, Monday through
Friday. Please note that we do not provide technical support on our toll free sales and information lines.

CD Read Me File
Last minute information that was not included in the printed documentation is available in the README.TXT
file located on the CD. You will find any information of this nature at the beginning of this file.
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Copyrights and Trademarks
HORTICOPIA products are protected by copyright and trademark laws. This chapter explains how the copyright
laws apply to your use of HORTICOPIA A to Z.

HORTICOPIA Trademarks
HORTICOPIA and Garden Workbench are registered trademarks of Horticopia, Inc.

Other Trademarks
Microsoft, Windows NT , Windows 95, Windows 98, and Windows 2000 are registered trademarks of Microsoft
Corporation.

Copyrights
All software, pictures, data and accompanying material are copyrighted. This information is protected by copyright
laws and international copyright treaties, as well as other intellectual property laws and treaties.
Copyright law will not prevent you from making reasonable use of the information and pictures contained on the
HORTICOPIA A to Z CD-ROM. HORTICOPIA users have frequently asked us what is permissible, so we are
providing some examples of both permissible and illegal use for your guidance. These examples are not to be
construed as any relinquishing of the copyright protection for this product.

Examples of Permissible Use
It is important to note that you cannot charge a fee or otherwise cause the recipient of any materials generated
with HORTICOPIA to incur an obligation to purchase materials or services. In all cases, the final materials
incorporating pictures or data from HORTICOPIA must be generated exclusively by your computer. You may not
copy, duplicate, reprint, print (except on the computer on which HORTICOPIA is installed), publish or otherwise
use HORTICOPIA materials.
•

Landscape proposals that include pictures from HORTICOPIA are a very common and popular use and is
permitted. However, the HORTICOPIA copyright notice must not be obliterated.

•

Signage used in garden centers or other retail display may be created with A to Z. Such signage may only be created
and used in the garden center. It may not be created by any service bureau or sold to another party.

•

Information sheets generated one at a time and provided without charge are permitted. You may not charge for
such information sheets nor produce them in commercial quantities.

Illegal Use
You may not sell any pictures or data or products containing pictures or data derived from HORTICOPIA.
You may not use any pictures or data from HORTICOPIA in any brochure, plant tags, plant labels, newsletter,
advertisement, catalog, website, or other commercial materials.
You may not make copies in commercial quantities of any printed output or other derived output of copyrighted
materials from HORTICOPIA. Educational users are typically allowed to make up to 25 copies of a printed
output.
You may not display photographs or other information as a photography exhibit or any other fashion not incidental
to your normal use. You must not use the pictures and data in a manner where they directly produce income to
you.

Copyrights and Trademarks
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All Digital Copies are Prohibited
In no event, may any digital form of HORTICOPIA be used except on the computer on which HORTICOPIA has
been installed. The End User Software License Agreement, found at the beginning of this User Guide, specifically
prohibits such copying or duplication. You may, for example, export pictures for use in another application on
your computer. You may not copy, reproduce or transmit such data or information. This prohibition includes but
is not limited to copying to a floppy disk, copying to another system on any network, electronic mail, website or
any other digital form of transmission. The sole exception is normal computer backup operations of that portion
of the software installed on your system by the HORTICOPIA setup procedure.
You may not make copies of the A to Z CD or any portions thereof. HORTICOPIA A to Z requires that the CD be
in a CD-ROM drive to operate. Do not copy the CD to a hard disk or elsewhere. If your A to Z CD should become
unusable (up to three years after its publication date), Horticopia, Inc. will exchange it for a service charge not to
exceed US$ 10 per damaged disk.
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